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This document is provided as a supplement to the DRV8811 datasheet. It details the hardware
implementation of the DRV8811 customer evaluation module (EVM).
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1 Introduction
The DRV8811EVM-001 customer EVM is the complete solution to evaluating the DRV8811 microstepping
bipolar stepper driver. It houses a USB link to provide easy control from a PC computer, an MSP430
microcontroller that interprets serial commands from the PC and generates control signals to the driver
device, and the DRV8811 device with access to all signals for a complete evaluation.

1.1 Block Diagram

1.2 Power Connectors
The DRV8811 customer EVM uses a combination of terminal blocks and test clips for the
application/monitoring of power. The only power rail the user must supply is VM for the device’s power
stage. VDD for logic levels is internally generated from the USB connection.

The user must apply VM according to datasheet recommended parameters.

1.3 Test Stakes
Every pin on the device has been brought out to a test stake. A label on the silkscreen identifies each
signal.
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1.4 Jumpers
Three pin jumpers can be configured independently from the other two or three pin jumpers. However, two
pin jumpers must either be closed or open. Two pin jumpers (JP2 to JP5) connect the diodes to the motor
outputs and are used under asynchronous rectification (SR = LO).

1.4.1 VREF SELECT (JP1) Jumper

Figure 1. VREF SELECT Jumper

To configure the VREF SELECT jumper: Figure 1 (a) selects an analog voltage derived from VDD through
a voltage divider implemented as a potentiometer R4. Figure 1 (b) selects an analog voltage derived from
the MSP430’s digital to analog converter channel 0 (DAC0).

1.4.2 DECAY SELECT (JP6) Jumper

Figure 2. DECAY SELECT Jumper

To configure the DECAY SELECT jumper: Figure 2 (a) selects an analog voltage derived from VDD
through a voltage divider implemented as a potentiometer R6. Figure 2 (b) selects an analog voltage
derived from the MSP430’s digital to analog converter channel 1 (DAC1).

1.5 Motor Outputs
There are three ways of connecting the bipolar stepper motor into the DRV8811 EVM: four pin header
(J2), four position terminal block (J3) or test clips. Each connection style offers identical connectivity to the
device’s output terminals. It is recommended, however, to use the header or terminal block, as the test
stakes traces are of low current handling capability.

2 Installing Drivers And Software

2.1 Installing the FTDI USB Driver
Instructions on how to install the FTDI USB driver on a Windows based computer are detailed in the
“USB_Drivers_Install_Readme.pdf” file supplied with the CD inside the USB_Driver folder.

2.2 GUI Software Installation
The following section explains the location of files and the procedure for installing the software correctly.

http://www.ti.com
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NOTE: Ensure that no USB connections are made to the EVM until the installation is completed.
The installer will also install LabVIEW RTE 2014 and FTDI Driver, along with the GUI.

2.2.1 System Requirements
• Supported OS – Windows 7 (32 Bit, 64 Bit). The window text size should be Smaller-100% (Default)
• Recommended RAM - 4 GB or higher
• Recommended CPU Operating Speed – 3.3 GHz or higher

2.2.2 Installation Procedure
The following procedure helps you install the DRV8811 GUI

1. Double click on the Setup_DRV8811_EVM.exe as shown in Figure 3.

Figure 3. Setup_DRV8811_EVM.exe

2. The screen shown in Figure 4 appears, indicating installer initialization. Click the Next button.

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLVA344C


Installing Drivers And Software www.ti.com

6 SLVA344C–July 2009–Revised July 2019
Submit Documentation Feedback

Copyright © 2009–2019, Texas Instruments Incorporated

Laser and Motor Drives

Figure 4. Installation Initialization

3. In the newly open installation pop-up window, click Next. The license agreement will be displayed.
Please, read through it carefully and enable the "I Accept the Agreement" radio button and press Next.

Figure 5. License Agreement

4. A screen as shown in Figure 6 appears, displaying the license agreement of National Instruments.
Please read through the agreement carefully and enable the “I Accept the License Agreement” radio
button and press the Next button.

http://www.ti.com
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Figure 6. NI License Agreement

5. Set the default directory for the GUI Installation and click Next.

Figure 7. Installation Directory Screen

NOTE: It is highly recommended to keep the default values as provided in the installer.

6. A screen as shown in Figure 8 appears. This screen is to select the components to install. Select the
Components to Install and Click Next to continue installation. The LabVIEW RTE component checks
out if the LabVIEW RTE 2014 is already installed on the PC.

http://www.ti.com
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Figure 8. Component Selection

7. If LabVIEW RTE is selected as a component to install, a screen appears as shown in Figure 9.
Configure the proxy settings as required. This screen is to download the LabVIEW RTE 2014 from
ni.com, Click Next to continue the installation.

Figure 9. Configure Proxy

8. A screen as shown in Figure 10 appears. Click Next to begin the installation.

http://www.ti.com
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Figure 10. Ready to Install

9. If the LabVIEW RTE 2014 is selected as a component to install, LabVIEW RTE downloads and
performs a silent mode installation.

Figure 11. Downloading RTE

10. Once the download completes, LabVIEW begins with the self-extraction as shown in Figure 12.

http://www.ti.com
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Figure 12. LabVIEW RTE Self Extraction

11. A Screen appears as shown in Figure 13. It initializes the LabVIEW RTE Installation.

Figure 13. LabVIEW RTE Installation Initialization

12. A display as shown in Figure 14 appears which indicates the progress of LabVIEW RTE installation.

http://www.ti.com
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Figure 14. Installation of LabVIEW RTE in Progress

13. Once the LabVIEW RTE 2014 is installed, DRV 8811 EVM GUI component installs.
14. After DRV8811 Installation, FTDI Installation begins. A screen as shown in Figure 15 appears, click

Extract to proceed.

http://www.ti.com
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Figure 15. FTDI Installation Initialization

15. A screen as shown in Figure 16 appears, click Next to proceed.

Figure 16. Driver Installation Wizard

http://www.ti.com
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16. The License Agreement appears on screen as shown in Figure 17.
17. Read through the License Agreement carefully and enable the “I Accept this Agreement” radio button

and Click on Next.

Figure 17. License Agreement for FTDI Driver

18. Click Finish to complete the Driver Installation.

http://www.ti.com
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Figure 18. Driver Installation Completion

19. Figure 19 appears denoting the completion of DRV8811 EVM GUI Installation. Click Finish.

Figure 19. Installation Complete

20. A Readme window as shown in Figure 20 appears displaying the link for LV 2014 RTE.

http://www.ti.com
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Figure 20. Readme Window

WARNING
The DRV8811 EVM GUI requires the LabVIEW Run-Time Engine
2014 to be installed before the GUI executes. Please note the
application is not compatible with other versions of LabVIEW
Runtime Engine.

You can download National Instruments LabVIEW Run-Time Engine 2014
from the below link:
LabVIEW Run-Time Engine 2014

NOTE: DRV8811 EVM GUI executable has been built in LabVIEW 2014 (32-bit) version, and it
expects the LabVIEW Run-Time Engine version to be LabVIEW Run-Time Engine (32-bit
version).

2.3 Running the Windows Application Software
To run the application, search for the desktop shortcut of the application or search for the DRV8811EVM
GUI in your Programs or its installation directory.

3 Windows Application
The DRV8811 Windows Application is the software counterpart for the DRV8811 EVM. It is in charge of
connecting to the MSP430 microcontroller via a USB connection which in turn selects the proper logic
state for the DRV8811 control signals.

The graphical user interface (GUI) has been designed to allow for all of the DRV8811 device’s
functionality to be tested without having to intervene with the hardware, except for the proper configuration
of jumpers when needed.

http://www.ti.com
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Figure 21 shows the GUI main screen. It contains menu items to configure and enable/disable the serial
port, frames with GPIO control for the DRV8811 control signals, stepper motor control for start/stop and
speed, and current/decay control through the MSP430 DACs.

Figure 21. DRV8811EVM-001_R1p0.exe Main Screen

http://www.ti.com
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3.1 Menu
• File - The File menu contains the option Exit as shown in Figure 22 below.

Figure 22. File Menu

• Debug - The Debug option can be used for the following operations.

Figure 23. Debug Menu

•
– Demo - By selecting the Demo in the submenu, the GUI runs in simulation mode, and by

unselecting it, the GUI runs in connected mode.
– Log to File - The log to file submenu is used to log the GUI activities to a log file that is specified.
– Debug log - The Debug log option enables to log all the activities of the user. If that is not selected,

only the high-level operations log.
• View - Select View-> Schematics->DRV8811 to view the GUIs schematics

Figure 24. Schematic

http://www.ti.com
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• Help
– Clicking the About in the Help Menu

Figure 25. Help Menu

– The About Page provides the details like the Name of the GUI, GUI version, Supported OS and
Copyright Information.

Figure 26. About Page

3.2 DRV8811 GPIO Control Signals
Once the application is communicating with the interface board, the control signals can be actuated by
checking or un-checking check boxes on the Signals frame.

http://www.ti.com
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Figure 27. Signals Frame

A checked checkbox translates to a HI level on the respective control signal. A un-checked checkbox
translates to a LO level on the respective control signal.

3.3 Updating DAC Output for Current Control (VREF/DECAY)
If the DRV8811 EVM has been configured to accept VREF analog voltages through the MSP430
microcontroller interface (JP1 is set to INT), then the slider bar on the Current Control frame can be used
to set the VREF voltage.

Figure 28. Curent Control Frame

The MSP430F1612 12-bit DAC channel 0 is connected to the DRV8811 VREF analog input. Changing the
DAC digital value from 0 to 4095, changes the analog voltage at the VREF/DECAY pin from 0 V to 2.5 V
respectively. See Equation 1.

(1)

Where VREF is the output voltage and DAC_VALUE is a number from 0 to 4095.

3.4 Updating DAC Output for Decay Control (DECAY)
If the DRV8811 EVM has been configured to accept DECAY analog voltages through the MSP430
microcontroller interface (JP6 is set to INT), then the slider bar on the Current Control frame can be used
to set the DECAY voltage.

http://www.ti.com
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Figure 29. Current Control Frame

The MSP430F1612 12 bit DAC channel 1 is connected to the DRV8811 DECAY analog input. Changing
the DAC digital value from 0 to 4095, changes the analog voltage at the DECAY pin from 0 V to 2.5 V
respectively. See Equation 2.

(2)

Where DECAY is the output voltage and DAC_VALUE is a number from 0 to 4095.

3.5 Operating the Stepper Motor

3.5.1 Turning the Stepper Motor
The Windows Application, in conjunction with the MSP430F1612 microcontroller, utilizes a series of timers
to coordinate the rate of steps sent to the device. Once all the control signals are configured accordingly
(ENABLEn = LO, SLEEPn = HI, RESETn = HI; DIR, USM0 and USM1 can be HI or LO depending on
preferred mode of operation; SRn must be L, if external diodes are not populated), the motor is ready to
be turned.

The DRV8811EVM-001 customer EVM allows for the possibility of coordinating step rates such that
accelerating and decelerating profiles are achieved. Both acceleration and deceleration are controlled by
the same parameters, acceleration rate and time base.

When the motor starts, it always starts at the slowed pulses per second (PPS) speed (62 pulses per
second). The controller will accelerate the motor in order to reach the PPS speed. Acceleration rate is an
8-bit number (0 to 255) that gets added to the current PPS speed and time base is an 8-bit number (0 to
255) that specifies how many milliseconds will elapse from one speed increase to the next. Once the
specified PPS speed has been achieved, the acceleration stops.

Figure 30. Step Rate

http://www.ti.com
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When the motor is commanded to stop, the inverse of the description above occurs.

The Windows Application frame to control speed, acceleration and deceleration, as well as motor start and
stop, looks as portrayed in Figure 31.

Figure 31. Speed Control Frame

Pressing the Start Steps button, will start the timer and pulses will be generated at the rate specified by
the decimal number at the PPS text box. Once the Start Steps button is pressed it becomes the Stepping
button. Press the Stepping button to stop the stepper motion.

When the motor is stepping, the Update Speed button becomes enabled. Speed can be updated by
modifying the PPS text box and then pressing the Update Speed button. The Update Speed button is
disabled every time the motor is not turning because the stepping has been halted by pressing the
Stepping button.

3.5.2 Step by Step control
The Step Control frame has a series of tools to control the stepping of the motor on a predetermined
number of steps fashion.

The Pulse Step button allows for a single step to be issued. At the same time, the STEP Control check
box allows the control of the STEP signal in the same fashion that other GPIO signals on the Signals
frame could be set and cleared. Checked stands for HI and unchecked for LO. Remember that a STEP
takes place when STEP goes from LO to HI.

Figure 32. Step Control Frame

To move the motor a number of steps and then stop, fill the # of Steps text box with a decimal number
from 0 to 65535 and the motor will move that number of steps at the speed specified on the PPS text box.
No acceleration or deceleration takes place under this function.

http://www.ti.com
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with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.
1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility

evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

2 Limited Warranty and Related Remedies/Disclaimers:
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User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or
replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
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professional electronics experts who are familiar with the dangers

and application risks associated with handling electrical mechanical
components, systems, and subsystems.

User shall operate the Evaluation Kit within TI’s recommended
guidelines and any applicable legal or environmental requirements
as well as reasonable and customary safeguards. Failure to set up

and/or operate the Evaluation Kit within TI’s recommended
guidelines may result in personal injury or death or property
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3 Regulatory Notices:
3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:
FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.
3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

FCC Interference Statement for Class B EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada
3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:
Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.

http://www.ti.com
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Concernant les EVMs avec antennes détachables
Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de
l'émetteur

3.3 Japan
3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page 日本国内に

輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified
by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):
1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal

Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けて
いないものがあります。 技術適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの
措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用

いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・イ

ンスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧ください。http:/
/www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

3.4 European Union
3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):

This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.

http://www.ti.com
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
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4 EVM Use Restrictions and Warnings:
4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT

LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.
4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling

or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:
4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user

guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a TI
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate
as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.

6. Disclaimers:
6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT

LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

http://www.ti.com
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8. Limitations on Damages and Liability:
8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,

INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief
in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2019, Texas Instruments Incorporated
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IMPORTANT NOTICE AND DISCLAIMER

TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS”
AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD
PARTY INTELLECTUAL PROPERTY RIGHTS.
These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate
TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable
standards, and any other safety, security, or other requirements. These resources are subject to change without notice. TI grants you
permission to use these resources only for development of an application that uses the TI products described in the resource. Other
reproduction and display of these resources is prohibited. No license is granted to any other TI intellectual property right or to any third
party intellectual property right. TI disclaims responsibility for, and you will fully indemnify TI and its representatives against, any claims,
damages, costs, losses, and liabilities arising out of your use of these resources.
TI’s products are provided subject to TI’s Terms of Sale (www.ti.com/legal/termsofsale.html) or other applicable terms available either on
ti.com or provided in conjunction with such TI products. TI’s provision of these resources does not expand or otherwise alter TI’s applicable
warranties or warranty disclaimers for TI products.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2019, Texas Instruments Incorporated

http://www.ti.com/legal/termsofsale.html
http://www.ti.com
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